Word Embeddings

Wei Xu
(many slides from Greg Durrett)

Administrivia
‣ Project 1 is released, due on 9/27
‣ Feedforward Neural Network for Fake News ClassiﬁcaPon
(+ extra credits on LSTM)

‣ Reading: Eisenstein 3.3.4, 14.5, 14.6, J+M 6, Goldberg 5

This Lecture
‣ Word representaPons
‣ word2vec/GloVe
‣ EvaluaPng word embeddings

Word RepresentaPons

SenPment Analysis
‣ Deep Averaging Networks: feedforward neural network on average of
word embeddings from input

Iyyer et al. (2015)

Word Embeddings
‣ Want a vector space where similar words have similar embeddings
the movie was great

great
good
enjoyable

~~
the movie was good
‣ Goal: come up with a way to
produce these embeddings
‣ For each word, want
“medium” dimensional vector
(50-300 dims) represenPng it.

dog

bad

is

Word RepresentaPons
‣ Neural networks work very well at conPnuous data, but words are discrete
‣ ConPnuous model <-> expects conPnuous semanPcs from input
‣ “You shall know a word by the company it keeps” Firth (1957)

slide credit: Dan Klein, Dan Jurafsky

Discrete Word RepresentaPons
‣ Brown clusters: hierarchical agglomeraPve hard clustering (each word has
one cluster, not some posterior distribuPon like in mixture models)
‣ Input: a (large) text corpus
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‣ Maximize P (wi |wi 1 ) = P (ci |ci 1 )P (wi |ci )
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‣ Useful features for tasks like NER, not suitable for Neural Networks
Brown et al. (1992)

Discrete Word RepresentaPons
‣ Brown clusters: hierarchical agglomeraPve hard clustering
‣ Example clusters from Miller et al. 2004

word cluster features (bit string prefix)

Discrete Word RepresentaPons
‣ Brown clusters: hierarchical agglomeraPve hard clustering
‣ We give a very brief sketch of the algorithm here:
k: a hyper-parameter, sort words by frequency
Take the top k most frequent words, put each of them in its own cluster 𝑐1, 𝑐2, 𝑐3,
For 𝑖 = (k + 1)… | 𝑉 |

…𝑐k

Create a new cluster 𝑐k+1 (we have k + 1 clusters)
Choose two clusters from k + 1 clusters based on quality(C) and merge (back to k clusters)
n

k

k

p(c,c')
Quality(C) = ∑ log e(wi | C(wi ))q(C(wi ) | C(wi−1 )) = ∑ ∑ p(c,c')log
+G
p(c)p(c')
i
c=1 c'=1
Carry out

k − 1 final merges (full hierarchy)

Running time

𝑂( 𝑉 k 2 + 𝑛) , n=#words in corpus

mutual information
between adjacent clusters

entropy of
the word distribution

Learn more: Percy Liang’s phd thesis - Semi-Supervised Learning for Natural Language

Word RepresentaPons
‣ Count-based: h*idf, PPMI, …
‣ Class-based: Brown Clusters, …
‣ Distributed predicPon-based embeddings: Word2vec (2013), GloVe (2014),
FastText, …
‣ Distributed contextual embeddings: ELMo (2018), BERT (2019), GPT, …
‣ + many more variants: mulP-sense embeddings, syntacPc embeddings, …

word2vec/GloVe

Neural ProbabilisPc Language Model

Bengio et al. (2003)

word2vec: ConPnuous Bag-of-Words
‣ Predict word from context
dog

d-dimensional
word embeddings
+

the

the dog bit the man
size |V|

W
size d

sommax

gold label = bit,
no manual labeling
required!

size |V| x d

P (w|w

1 , w+1 )

= softmax (W (c(w

1)

+ c(w+1 )))

‣ Parameters: d x |V| (one d-length context vector per voc word),
|V| x d output parameters (W)
Mikolov et al. (2013)

word2vec: Skip-Gram
‣ Predict one word of context from word
d-dimensional
word embeddings

the dog bit the man

gold label = dog

W
bit

sommax

0

P (w |w) = softmax(W e(w))

size |V| x d

‣ Another training example: bit -> the
‣ Parameters: d x |V| vectors, |V| x d output parameters (W) (also
usable as vectors!)
Mikolov et al. (2013)

Hierarchical Sommax
P (w|w

1 , w+1 )

= softmax (W (c(w

1)

+ c(w+1 )))

0

P (w |w) = softmax(W e(w))

‣ Matmul + sommax over |V| is very slow to compute for CBOW and SG
…
…

‣ Standard sommax:
O(|V|) dot products of size d
- per training instance per
context word

‣ Huﬀman encode
vocabulary, use binary
classiﬁers to decide
which branch to take

the
log(|V|)
binary
decisions
‣
a
‣ Hierarchical sommax:
O(log(|V|)) dot products of size d,
|V| x d parameters
Mikolov et al. (2013)
http://building-babylon.net/2017/08/01/hierarchical-softmax/

Skip-Gram with NegaPve Sampling
‣ Take (word, context) pairs and classify them as “real” or not. Create
random negaPve examples by sampling from unigram distribuPon
(bit, the) => +1
(bit, cat) => -1
(bit, a) => -1
(bit, ﬁsh) => -1

the dog bit the man

P (y = 1|w, c) =

e

w·c

w·c
e

+1

words in similar
contexts select for
similar c vectors

n
# of params as before)
‣ d x |V| vectors, d x |V| context vectors1 (same
X
log P (y = 1|w, c)
log P (y = 0|wi , c)
sampled
k
n
X
i=1
1
‣ ObjecPve = log P (y = 1|w, c)
log P (y = 0|wi , c)

k

i=1

Mikolov et al. (2013)

ConnecPons with Matrix FactorizaPon
‣ Skip-gram model looks at word-word co-occurrences and produces two
types of vectors
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Two words are “similar” in meaning if their context vectors are similar. Similarity == relatedness

ConnecPons with Matrix FactorizaPon
‣ Skip-gram model looks at word-word co-occurrences and produces two
types of vectors
|V|
|V|

word pair
counts

d
word
|V|
vecs

|V|
context vecs d

‣ Looks almost like a matrix factorizaPon…can we interpret it this way?
Levy et al. (2014)

Skip-Gram as Matrix FactorizaPon
|V|
|V|

num negaPve samples

Mij = PMI(wi , cj )

log k

P (wi , cj )
PMI(wi , cj ) =
=
P (wi )P (cj )

count(wi ,cj )
D
count(wi ) count(cj )
D
D

Skip-gram objecPve exactly corresponds to factoring this matrix:
‣ If we sample negaPve examples from the uniform distribuPon over words
‣ …and it’s a weighted factorizaPon problem (weighted by word freq)
Levy et al. (2014)

Co-occurence Matrix
‣ Typical problems in word-word co-occurrences:
‣ Raw frequency is not the best measure of associaPon between words.
‣ Frequent words are omen more important than rare words that only
appear once or twice;
‣ But, frequent words (e.g., the) that appear in all documents are also
not very useful signal.
‣ SoluPons — weighing terms in word-word/word-doc co-occurrence matrix
‣ Tf*idf
‣ PPMI (PosiPve Pairwise Mutual InformaPon)

Co-occurence Matrix
word-doc co-occurrences

‣ Tf*idf
‣ Tf: term frequency

As You Like It Twelfth Night Julius Caesar

𝑡𝑓 = log10(count(𝑡, 𝑑) + 1)
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‣ Idf: inverse document frequency
𝑁
𝑖𝑑𝑓𝑖 = log10(
)
𝑑𝑓𝑖

Henry V

Total number of docs
in collecPon
number of docs that
have word i

GloVe (Global Vectors)
|V|
‣ Also operates on counts matrix, weighted
regression on the log co-occurrence matrix

‣ Loss

=

X

f (count(wi , cj ))

>
w i cj

|V|

+ a i + bj

word pair
counts

log count(wi , cj ))

2

i,j

‣ Constant in the dataset size (just need counts), quadraPc in voc size
‣ By far the most common non-contextual word vectors used today
(10000+ citaPons)
Pennington et al. (2014)

Using Word Embeddings
‣ Approach 1: learn embeddings as parameters from your data
‣ Omen works preyy well
‣ Approach 2: iniPalize using GloVe/word2vec/ELMo, keep ﬁxed
‣ Faster because no need to update these parameters
‣ Approach 3: iniPalize using GloVe, ﬁne-tune
‣ Works best for some tasks, not used for ELMo, omen used for BERT

NER in Twiyer

2m 2ma 2mar 2mara 2maro 2marrow 2mor 2mora
2moro 2morow 2morr 2morro 2morrow 2moz 2mr
2mro 2mrrw 2mrw 2mw tmmrw tmo tmoro tmorrow
tmoz tmr tmro tmrow tmrrow tmrrw tmrw tmrww tmw
tomaro tomarow tomarro tomarrow tomm tommarow
tommarrow tommoro tommorow tommorrow
tommorw tommrow tomo tomolo tomoro tomorow
tomorro tomorrw tomoz tomrw tomz

Riyer et al. (2011)

Word2vec
Both

Cherry & Guo (2015)

EvaluaPon

VisualizaPon

Source: tensorflow.org

VisualizaPon

Kulkarni et al. (2015)

EvaluaPng Word Embeddings
‣ What properPes of language should word embeddings capture?
‣ Similarity: similar words are close to
each other
cat

‣ Analogy:
good is to best as smart is to ???

great
good
enjoyable

dog

Paris is to France as Tokyo is to ???
>ger
wolf

bad

was is

Word Similarity
‣ Cosine Similarity:

→
→
cosine( 𝑣 , 𝑤 ) =

→
→
𝑣 ⋅𝑤
=
→
→
𝑣 |𝑤|

𝑁
∑𝑖=1 𝑣𝑖𝑤𝑖
𝑁
∑𝑖=1 𝑣𝑖2

𝑁
∑𝑖=1 𝑤𝑖2

Levy et al. (2015)

Word Similarity
Word2vec

‣ SVD = singular value decomposiPon on PMI matrix
‣ GloVe does not appear to be the best when experiments are carefully
controlled, but it depends on hyperparameters + these disPncPons don’t
mayer in pracPce
Levy et al. (2015)

Hypernym DetecPon
‣ Hypernyms: detecPve is a person, dog is a animal
‣ Do word vectors encode these relaPonships?

‣ word2vec (SGNS) works barely beyer than random guessing here
Chang et al. (2017)

®
WordNet
‣ created (since mid-1980s) and maintained by CogniPve Science Lab of
Princeton University
‣ designed to establish the connecPons between words
‣ a combinaPon of dicPonary and thesaurus (>155k English words)
‣ 4 types of Parts of Speech (POS) - noun, verb, adjecPve, adverb
‣ “Synset” (synonym set) is the smallest unit in WordNet, represenPng
a speciﬁc meaning of a word

®
WordNet

hypernym

hyponym

Analogies
(king - man) + woman = queen
king + (woman - man) = queen

king
queen

‣ Why would this be?
‣ woman - man captures the diﬀerence in
the contexts that these occur in
‣ Dominant change: more “he” with man
and “she” with woman — similar to
diﬀerence between king and queen

man
woman

Analogies

‣ These methods can perform well on analogies on two diﬀerent
datasets using two diﬀerent methods
Maximizing for b: Add = cos(b, a2

a 1 + b1 )

cos(b2 , a2 ) cos(b2 , b1 )
Mul =
cos(b2 , a1 ) + ✏

Levy et al. (2015)

Takeaways
‣ Word vectors: learning word -> context mappings has given way to
matrix factorizaPon approaches (constant in dataset size)
‣ Lots of pretrained embeddings work well in pracPce, they capture some
desirable properPes
‣ Even beyer: context-sensiPve word embeddings (ELMo/BERT/etc.) —
will talk later in the semester
‣ Next Pme: sequence modeling, HMM, …

Preview: Context-dependent Embeddings
‣ How to handle diﬀerent word senses? One vector for balls

balls
balls
they dance
they
at
the
hit
‣ Train a neural language model to predict the next word given previous
words in the sentence, use its internal representaPons as word vectors
‣ Context-sensi>ve word embeddings: depend on rest of the sentence
‣ Huge improvements across nearly all NLP tasks over word2vec & GloVe
Peters et al. (2018)

Final Project

Final Project
‣ Groups Size: 2-3 people; 1 is possible (email me for permission).
‣ Submission (slightly changed grading schema):
‣ 2-page project proposal (5%, due 10/10)
‣ 4-page midway report (5%)
‣ 8-page ﬁnal report (17%) + ﬁnal oral presentaJon (3%)
(detailed instrucJons on the submission will be released later)
‣ Example project reports — see Stanford CS224’s past projects
hLps://web.stanford.edu/class/cs224n/project.html
‣ Prize: We will give out 1-3 best project awards. !

Final Project
‣ Shared project with other classes is allowed
‣ project is expected to be accordingly bigger/beLer
‣ clearly declare at the beginning of your report that you are sharing project
(with which class)
‣ External collaborators (e.g. non CS7650 students, phd advisor) are also allowed
‣ clearly describe in the report which parts of the projects are your work

Project Proposal (5%)
‣ Two pages total
‣ 1-page summary of a relevant (key) research paper for your topic
‣ Bibliographical informaJon,
‣ Background (moJvaJon, related work, why this work is important),
‣ ContribuJons (what’s new this paper added to the ongoing research
conversaJon — new algorithms, new experimental results and analysis, new
meta-analysis of old papers, new datasets, or otherwise?)
‣ LimitaJons and discussion (every paper has limitaJons and ﬂaws)
‣ Why this paper? What is the wider research context?

Project Proposal (5%)
‣ 1-page summary of what you plan to and how you can innovate?
‣ Main goal and moJvaJon of your project — why it is cool? why it is useful?
‣ What NLP tasks(s)?
‣ What data?
‣ What methods?
‣ What baseline?
‣ How will you evaluate your results?

Why Project Proposal?
‣ From Chris Manning —

Why Project Proposal?
‣ From Jason Eisner —

https://www.cs.jhu.edu/~jason/advice/how-to-read-a-paper.html
https://www.cs.jhu.edu/~jason/advice/write-the-paper-first.html

Finding Research Topics
‣ Two basic starJng points, for all of science:
‣ Nails — start with a (domain) problem of interest and try to ﬁnd
good/beLer ways to address it than are currently known/used
‣ Hammers — start with a technical method/approach of interest,
and work out good ways to extend or improve it or new ways to
apply it

Credit: Stanford CS224n, Chris Manning

Typical Project Types
‣ This is not an exhausJve list —
‣ 1) Find an applicaJon/task of interest and explore how to approach/solve
it eﬀecJvely, ocen with an exisJng model
‣ Could be task in the wild or some exisJng dataset or shared task
(e.g.. WNUT or SemEval, etc.)
‣ Or dialogue system, QA system, …
‣ 2) Analyze the behavior of models or exisJng datasets
‣ how the model represents linguisJc knowledge or what kinds of
phenomena it can handle or errors that it makes.
‣ what linguisJc phenomena/errors exist in the dataset, how they
aﬀect model performance.

Credit: Stanford CS224n, Chris Manning

Typical Project Types
‣ This is not an exhausJve list —
‣ 3) Create a new dataset, conduct some analysis, train a predicJon model
‣ for a new topic/task, or for an exisJng task but beLer way to create
higher quality dataset
‣ may involve some manual annotaJon
‣ conduct some quanJJve and linguisJc analyses
‣ 4) Implement a complex neural architecture and demonstrate its
performance on some data, especially for non-English data
‣ 5) Come up with a new or variant neural network model and explore its
empirical success (but this has become harder since 2020 — )
Credit: Stanford CS224n, Chris Manning

Place to start?
‣ Look at ACL Anthology for NLP papers:
‣ hLps://aclanthology.org/
‣ Also look at the online proceedings of major ML/Web conferences
‣ ICLR, NeurIPS , ICML
‣ SIGIR, Web Conference, ICWSM (hLps://www.icwsm.org/2021/)
‣ Look at online preprint servers, especially:
‣ hLps://arxiv.org/
‣ Look for an interesJng problem in the world!
‣ PsycholinguisJcs, computaJonal social science, journalism, …

Finding a Topic
‣ Turing award winner and Stanford CS emeritus professor Ed Feigenbaum
says to follow the advice of his advisor, AI pioneer, and Turing and Nobel
prize winner Herb Simon:
“If you see a research area where many people are working, go
somewhere else.”
‣ But where to go? Wayne Gretzky:
“I skate to where the puck is going, not where it has been.”
(Slides 51-55: https://web.stanford.edu/class/cs224n/slides/cs224n-2022-lecture08-final-project.pdf)

Credit: Stanford CS224n, Chris Manning

Finding Data
‣ Some people collect their own data for a project — we like that!
‣ You may have a project that uses “unsupervised” data
‣ You can annotate a small amount of data
‣ You can ﬁnd a website that eﬀecJvely provides annotaJons, such as
likes, starts, raJng, responses, etc.
‣ Look at research papers to see what data they use, how they get it
‣ Many others make use of exisJng datasets built by other researchers
‣ Shared task at WNUT, WMT, SemEval, etc.
‣ Datasets used in other papers (e.g. hLps://aclanthology.org/)
Credit: Stanford CS224n, Chris Manning

Final Project Writeup/PresentaJon
‣ Up to 8-page writeup due the day before ﬁnal exam date (no late submission!)
‣ Use LaTeX template from ACL
‣ Include references; statement of each group members’ contribuJon
‣ Writeup quality is important to your grade!
‣ X-minute oral presentaMon at the ﬁnal exam Mme (X ∈ [3, 8])

Credit: Stanford CS224n

Have fun with your project!

